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1 INTRODUÇÃO 

De acordo com o artigo 37.º, n.º 4, do Regulamento (CE) n.º 1907/2006 («o Regulamento 
REACH»), o utilizador a jusante de uma substância, estreme ou contida numa mistura, deve 
elaborar um relatório de segurança química para qualquer utilização que não se enquadre 
nas condições descritas num cenário de exposição ou, se for adequado, para uma categoria 
de utilização e de exposição que lhe tenha sido comunicada numa ficha de dados de 
segurança ou para qualquer utilização desaconselhada pelo fornecedor. No entanto, o artigo 
37.º, n.º 4, segundo parágrafo, do Regulamento REACH, identifica seis casos em que o 
utilizador a jusante está isento de elaborar um relatório de segurança química.  

O artigo 38.º especifica as informações que o utilizador a jusante deve transmitir à Agência 
Europeia dos Produtos Químicos (ECHA) no caso de ter de elaborar um relatório de 
segurança química ou quando são aplicáveis ao utilizador a jusante as isenções 
previstas no artigo 37,º. n.º 4, alíneas c) ou f).. 

O presente manual tem por objectivo ajudar o utilizador a jusante a elaborar um relatório na 
IUCLID 5, nos termos do artigo 38.º do Regulamento REACH. Mais especificamente, 
identifica, no capítulo 5, entre os vários campos da IUCLID 5, aqueles que são de primeira 
importância para uma apresentação correcta de um relatório de utilizador a jusante que 
contenha as informações exigidas no artigo 38.º, n.º 2, do Regulamento REACH.  

Só então o relatório de utilizador a jusante na IUCLID 5 pode ser apresentado à Agência 
Europeia dos Produtos Químicos (ECHA), através da aplicação REACH-IT. 

O manual parte do princípio que a IUCLID 5 foi instalada e que o utilizador possui uma 
conta, atribuída à entidade jurídica, criada durante a instalação da IUCLID 5. Caso a IUCLID 
5 não esteja ainda instalada, consulte o sítio Web da IUCLID, disponível em: 

http://iuclid.echa.europa.eu 

Neste sítio Web, pode transferir o software gratuitamente, bem como encontrar orientações 
mais abrangentes sobre a utilização da IUCLID 5. Pode também transferir a versão mais 
recente da ferramenta de Verificação Técnica de Integralidade (plug-in BR/TCC IUCLID), 
que lhe permitirá certificar-se de que apresentou todas as informações necessárias no seu 
dossiê da IUCLID 5 antes de o apresentar à Agência. 

 

 O presente manual foi elaborado para apoiar a criação de dossiês nas versões 
IUCLID 5.3 e posteriores.  

O REACH-IT apenas aceita dossiês de relatórios de utilizadores a jusante preparados 
com as versões IUCLID 5.3 e posteriores. 

Se utilizar versões anteriores da IUCLID 5, os dados devem ser migrados e 
actualizados para a nova versão. Para mais informações, consulte o sítio Web da 
IUCLID 5, disponível em: 

http://iuclid.echa.europa.eu  

 

 Para mais informações sobre as obrigações relativas aos relatórios dos utilizadores a 
jusante nos termos do Regulamento REACH, consulte as Orientações para os 
utilizadores a jusante, disponíveis em: 

http://guidance.echa.europa.eu/docs/guidance_document/du_pt.pdf?vers=29_01_08 

http://iuclid.echa.europa.eu/
http://iuclid.echa.europa.eu/
http://guidance.echa.europa.eu/docs/guidance_document/du_en.pdf?vers=29_01_08
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A figura abaixo sintetiza a preparação de um relatório de utilizador a jusante na IUCLID 5: 

Figura 1: Perspectiva geral da criação de um relatório de utilizador a jusante na IUCLID 5 

Passo 1: criar a entidade jurídica para o utilizador a jusante 
(ver capítulo 2 do manual)

Passo 2: criar as substâncias de referência relacionadas com a substância comunicada
(ver capítulo 3 do manual)

Passo 3: criar o conjunto de dados da substância para a substância comunicada
(ver capítulo 4 do manual)

Passo 4: introduzir as informações relativas à substância comunicada
(ver capítulo 5 do manual)

Passo 5: criar um dossiê do relatório do utilizador a jusante
(ver capítulo 6 do manual)

Passo 6: exportar da IUCLID 5 o dossiê do relatório do utilizador a jusante
(ver capítulo 7 do manual)

Passo 7: apresentar à Agência o dossiê do relatório do utilizador a jusante 
(ver capítulo 9 do manual)

 

 

 Se já é um utilizador experiente da IUCLID 5 e sabe como criar uma entidade 
jurídica, substâncias de referência e conjuntos de dados de substâncias, 
recomendamos que passe directamente ao capítulo 5 do presente manual, onde 
encontrará informações sobre o preenchimento correcto do seu relatório de 
utilizador a jusante. 
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2 ENTIDADES JURÍDICAS 

 Se já é um utilizador experiente da IUCLID 5 e sabe como criar uma entidade 
jurídica, recomendamos que passe directamente ao capítulo 5 do presente 
manual, onde encontrará informações sobre o preenchimento correcto do seu 
relatório de utilizador a jusante. 

 

Na IUCLID 5, as «Entidades jurídicas» são utilizadas para fornecer informações de contacto 
sobre as empresas envolvidas em processos no âmbito do Regulamento REACH. As 
informações da Entidade Jurídica são armazenadas num denominado Objecto da Entidade 
Jurídica (LEO). 

A informação mais importante existente num objecto da entidade jurídica é a «company 
UUID» [identificador universal único da empresa]. Esta informação não pode ser editada: é 
só de leitura no objecto da entidade jurídica. O REACH-IT utiliza apenas o identificador 
universal único da empresa para identificar a empresa em todos os processamentos de 
dados que efectua. Por conseguinte, é importante que o UUID do objecto da entidade 
jurídica seja idêntico em todos os cenários em que a identidade da empresa é apresentada 
(IUCLID 5, REACH-IT e quaisquer formulários Web enviados à Agência). 

É obrigatório um objecto da entidade jurídica oficial, tanto para a inscrição no REACH-IT, 
como para a instalação da aplicação IUCLID 5 num ambiente local. Dependendo de a 
empresa se inscrever no REACH-IT e/ou na página Web da IUCLID, existem as seguintes 
possibilidades para sincronizar o objecto da entidade jurídica com ambas as aplicações (ver 
Figura 2): 

 Se a sua empresa ainda não se inscreveu no REACH-IT nem no sítio Web da IUCLID 5, 
será mais aconselhável criar um objecto da entidade jurídica no sítio Web da IUCLID 5. 
A criação de uma entidade jurídica oficial é efectuada durante a instalação e 
transferência da IUCLID 5 (para mais informações sobre a transferência e instalação da 
IUCLID 5, consulte http://iuclid.echa.europa.eu ). O ficheiro do objecto da entidade 
jurídica gerado no formato XML (LEOX) poderá então ser importado para a sua 
instalação local da IUCLID 5 e para o REACH-IT, assegurando a sincronização das 
informações (nome da empresa, informações de contacto, UUID). 

 Se a sua empresa já tem uma conta activa no REACH-IT mas ainda tem de instalar a 
IUCLID 5, é aconselhável exportar o ficheiro do objecto da entidade jurídica em formato 
XML (LEOX) do REACH-IT para a sua instalação local da IUCLID 5. Para tal, aceda ao 
separador <Company> [Empresa] do menu principal do REACH-IT e seleccione 
<Export> [Exportar]. O ficheiro LEOX será guardado no computador local, de onde 
poderá ser importado para a IUCLID 5. 

 Se a sua empresa já tiver instalado a IUCLID 5 e criado um objecto da entidade jurídica 
oficial no sítio Web da IUCLID 5, mas ainda tiver de proceder à inscrição no REACH-IT, 
é aconselhável importar o ficheiro LEOX existente para o REACH-IT durante o processo 
de registo. Esta tarefa é realizada durante o passo 2 «Company information» 
[Informações da empresa] do processo de registo, na qual é solicitado ao utilizador que 
carregue um ficheiro LEOX existente. 

 

http://iuclid.echa.europa.eu/
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Se a sua empresa tiver uma conta REACH-IT e uma instalação da IUCLID 5, mas não tiver 
a certeza de que os identificadores universais únicos da empresa são coincidentes nas duas 
aplicações, proceda da seguinte forma: 

 Aceda ao menu principal do REACH-IT e, em <Company> [Empresa], seleccione 
<View> [Ver]. O UUID da empresa no REACH-IT é apresentado na segunda linha em 
“Company information” [Informações da empresa]. 

 Na sua instalação da IUCLID 5, aceda a “Legal entity” [Entidade Jurídica] no painel 
principal de tarefas. Seleccione «Update» [Actualizar] e faça duplo clique na Entidade 
Jurídica pertinente da lista «Query results» [Resultados da consulta]. O UUID da 
empresa é apresentado no separador «Information» [Informações] na parte inferior da 
janela da IUCLID 5.  

 Caso existam várias entidades jurídicas na IUCLID 5 com o mesmo nome mas UUID 
diferentes, poderá ser útil manter apenas o IUUID que corresponde ao do REACH-IT 
como «Active trade partner» [Parceiro comercial activo] Para o efeito, clique com o 
botão direito do rato na entidade jurídica da lista «Query results» [Resultados da 
procura] e active/desactive as entidades jurídicas conforme aplicável. As entidades 
jurídicas de «Active trade partner» [Parceiro comercial activo] são apresentadas a 
negrito; as entidades inactivas são apresentadas com formato de letra normal. Esta 
operação serve apenas para ajuda visual e pode ser alterada em qualquer altura.   

 



Manual de Apresentação de Dados 

Parte 21 - Como preparar e apresentar um 
relatório de utilizador a jusante 
através da IUCLID 5  

 

Versão 1.0  Página 10 de 68 

Data de publicação (04-2011)  

 

Figura 2  Transferência de um Objecto da Entidade Jurídica (LEO) entre o sítio Web da IUCLID e o 
REACH-IT através de um ficheiro LEOX. 

 

Figure 2 Figura 2 
IUCLID 5 – IUCLID Website IUCLID 5 – sítio Web da IUCLID 
Company sign-up using a LEOX that contains 
a LEO that was created on the IUCLID web 
site 

Inscrição da empresa utilizando um ficheiro 
LEOX que contém um LEO criado no sítio 
Web da IUCLID 

ECHA REACH-IT ECHA REACH-IT 
Transfer, in the form of a LEOX, either 1) a 
LEO that was created by REACH-IT durante 
company sign-up Or 2) a LEO that was 
created on the IUCLID web site and used 
during company sign-up 

Transferir, no formato de um ficheiro LEOX, 
1) um LEO criado pelo REACH-IT durante a 
inscrição da empresa; Ou 2) um LEO criado 
no sítio Web da IUCLID e utilizado durante a 
inscrição da empresa 

Company sign-up using a LEOX that contains 
a LEO that was created on the IUCLID web 
site 

Inscrição da empresa utilizando um ficheiro 
LEOX que contém um LEO criado no sítio 
Web da IUCLID 

IUCLID 5 – Local IUCLID installation IUCLID 5 – instalação local da IUCLID 
Transfer, in the form of a LEOX, a LEO that 
was created on the IUCLID web site 

Transferir, no formato de um ficheiro LEOX, 
um LEO criado no sítio Web da IUCLID 

 
 

 A forma normal de inserir as informações da empresa no REACH-IT durante o 
processo de registo consiste na importação de um objecto da entidade jurídica (LEO) 
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da IUCLID 5 já preparado com o formato LEOX (Figura 2).  

No processo de registo, se uma entidade não dispuser de um objecto da entidade 
jurídica no formato LEOX, o REACH-IT poderá utilizar as informações introduzidas 
manualmente pela entidade na interface do REACH-IT para criar um objecto da 
entidade jurídica (Figura 2).  

 Para mais informações sobre como criar um objecto da entidade jurídica (LEO) e 
como sincronizá-lo com a IUCLID 5 e o REACH-IT, consulte o capítulo 2.4 («Objecto 
da Entidade Jurídica») do «Manual de utilização para a Indústria, Parte 2 – Inscrição 
e gestão de conta» do REACH-IT em: 
http://echa.europa.eu/doc/reachit/industry_user_manual/ium2/reachit_signup_accmng
t_pt.pdf 

 O REACH-IT apenas utiliza o ID de empresa para identificar a empresa em todos os 
processamentos de dados que efectua. Por conseguinte, é importante que o UUID do 
objecto da entidade jurídica seja idêntico em todos os contextos em que a identidade 
da empresa é apresentada. 

 

http://echa.europa.eu/doc/reachit/industry_user_manual/reachit_signup_accmngt_en.pdf
http://echa.europa.eu/doc/reachit/industry_user_manual/reachit_signup_accmngt_en.pdf
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3 SUBSTÂNCIAS DE REFERÊNCIA 

 Se já é um utilizador experiente da IUCLID 5 e sabe como criar substâncias de 
referência, poderá aceder directamente ao capítulo 5 do presente manual, onde 
encontrará informações sobre o preenchimento correcto do seu relatório de 
utilizador a jusante. 

 

Para identificar correctamente a substância que pretende notificar, é importante 
compreender o conceito de Substância, Conjunto de Dados de uma Substância e 
Substância de Referência na IUCLID 5. 

O relatório de utilizador a jusante é preparado para uma substância (definida nos termos do 
artigo 3.º, n.º 1, do Regulamento REACH). 

Na IUCLID 5, as informações relacionadas com essa substância (a identidade da 
substância, a sua composição, etc.) devem ser especificadas no conjunto de dados criado 
para essa substância. 

Para inserir as informações relativas à identidade da sua substância e respectivos 
constituintes no conjunto de dados, deverá utilizar o conceito de substância de referência. 
Uma substância de referência não é mais do que uma ligação à identidade de uma 
substância química. O conceito de substância de referência permite armazenar num local 
central informações de identificação relativas a uma dada substância ou a um dado 
constituinte de uma substância, por exemplo, nomes de produtos químicos (nome CE, nome 
CAS, nome IUPAC, sinónimos, etc.), códigos de identidade (por exemplo, número CE, 
número CAS), informação molecular e estrutural. Estas informações podem depois ser 
reutilizadas noutros conjuntos de dados sem ser necessário reeintroduzi-las. O inventário de 
substâncias de referência é mantido directamente pelo utilizador na sua instalação local. 

Para aumentar o número de entradas no inventário de substâncias de referência, 
recomenda-se a transferência das cerca de 70 000 substâncias de referência pré-
preenchidas a partir do sítio Web da IUCLID 5 e a sua importação para a instalação local (a 
menos que já o tenha feito durante a instalação da IUCLID 5). Estas substâncias de 
referência predefinidas foram preparadas para melhorar a qualidade dos dados e minimizar 
a introdução de dados. No entanto, é aplicável a seguinte declaração de exoneração de 
responsabilidade: 

http://echa.europa.eu/disclaimer_en.asp 

Além disso, deverá também transferir o inventário CE do sítio Web da IUCLID (a menos que 
já o tenha feito durante a instalação da IUCLID 5). Este inventário é constituído por uma lista 
de identidades de substâncias baseada numa conjugação dos seguintes inventários 
europeus: EINECS, ELINCS e lista de NLP. 

Nesta secção do manual, poderá encontrar o procedimento a seguir para pesquisar, 
actualizar e criar as substâncias de referência a atribuir à sua substância, directamente a 
partir do painel principal de tarefas. Tenha em atenção que também é possível criar uma 
substância de referência directamente a partir do conjunto de dados da substância (Capítulo 
4). 

http://echa.europa.eu/disclaimer_en.asp
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3.1 Consultar/actualizar substâncias de referência no inventário 

 Clique em «Update» [Actualizar] em «Reference substance» [Substância de referência] 
no painel principal de tarefas da IUCLID (Figura 3). 

Figura 3: Ligação de actualização na substância de referência 

 

 Se, durante a instalação da IUCLID 5, tiver optado por transferir e instalar o inventário de 
Substâncias de referência, terá aproximadamente 70 000 substâncias de referência 
armazenadas no seu computador. Será apresentado um aviso a indicar que o limite 
predefinido de consulta é de 500 itens (Figura 4). Se responder «Yes» [Sim], a consulta 
de todas as substâncias de referência será ignorada na próxima vez que actualizar o 
inventário. Se responder «No» [Não], a IUCLID 5 obterá a totalidade da lista de 
substâncias de referência na próxima vez que actualizar o inventário de substâncias de 
referência. De qualquer modo, será redireccionado para o ecrã «Reference substances» 
[Substâncias de referência]. 

 

Figura 4: Limite de consulta atingido 

 

 Clique no botão <Query> [Consultar] (Figura 5). 

 

Figura 5: Botão de consulta 

 

 É apresentada uma caixa de diálogo. Seleccione «Find Reference substances» 
[Localizar substâncias de referência] na lista de opções «Select query» [Seleccionar 
consulta] (Figure 6). 
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Figura 6: Lista de opções da consulta 

 

 

 Escreva os critérios de selecção da substância que está a procurar e clique em 
<Search> [Pesquisar]. Pode utilizar o asterisco (*) como carácter universal. Por exemplo, 
para obter todas as substâncias começadas por «eta», escreva «eta*». Para obter todas 
as substâncias terminadas em «amina», escreva «*amina» (tenha em atenção que 
apenas serão apresentados 2 000 resultados). 

Figura 7: Pesquisar uma substância de referência 

 

 Faça duplo clique na substância de referência para visualizar os dados associados 
(Figura 8).  
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Figura 8: Visualizar dados 

 

 Analisar os dados relativos à substância de referência. Para actualizar/adicionar 
quaisquer informações relativas à substância de referência, clique no botão <Edit item> 

[Editar item] ( ) na barra de ferramentas situada na parte superior do ecrã, edite as 
informações sobre a substância de referência e guarde as alterações clicando no botão 

. 

 

3.2 Criar uma substância de referência 
Se não encontrar a substância de referência de que necessita no inventário de substâncias 
de referência, poderá criá-la utilizando o procedimento seguinte: 

 No ecrã principal, aceda aos inventários e, em «Reference substance» [Substância de 
referência], clique em «New» [Novo] (Figura 9). 

Figura 9: Nova ligação na substância de referência 

 

 

 Escreva o nome da substância de referência na janela de pop-up «Reference substance 
assistant» [Assistente de substância de referência]. Deve assinalar a caixa «Active 
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Reference substance» [Substância de referência activa], uma vez que apenas as 
substâncias de referência marcadas como «active» [activa] podem ser utilizadas durante 
a criação de um conjunto de dados de uma substância (Figura 10). 

Figura 10: Adicionar o nome da substância de referência 

 

 

 Seleccione o botão <Finish> [Concluir]; a substância de referência é criada e é 
apresentada uma secção Substância de referência vazia (Figura 11). Clique no botão 
<Edit item> [Editar item]. 

Figura 11: Secção Substância de referência 

 

 Se a substância de referência existir no inventário CE: 

o clique no botão  para atribuir essa entrada. É apresentada a caixa de 
diálogo de consulta, onde é possível pesquisar as entradas do inventário CE 
(Figura 12); 

o pesquisar utilizando qualquer um dos critérios apresentados, tal como o nome 
CE da substância. Também aqui pode utilizar «*» como carácter universal; 
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Figura 12: Pesquisar uma substância de referência 

 

o realce na lista a entrada que corresponde à sua substância de referência; 

o Clique no botão <Assign> [Atribuir]. As informações desta substância de 
referência serão incluídas na nova substância de referência. 

 Se a sua substância de referência não existir no inventário CE, seleccione uma 
justificação na lista de opções proposta na secção «No EC information available» 
[Nenhuma informação CE disponível] (Figura 13). 

Figura 13: Campo Justificação 

 

 Preencha tanto quanto possível os restantes campos da substância de referência. 

Ao preencher as informações da sua substância de referência, deve incluir as seguintes 
informações para todos os constituintes e impurezas: 

o Número CE e nome CE (caso existam); 

o Número CAS e nome CAS (caso existam); 

o Nome IUPAC; 

o Descrição (especifique quaisquer informações adicionais relevantes para a 
descrição da substância de referência neste campo); 

o Fórmula molecular (se não for possível determinar uma fórmula molecular a 
partir da substância de referência, deverá ser indicada uma justificação no 
campo «Remarks» [Observações] na parte inferior do ecrã); 

o Intervalo de massas moleculares (se aplicável); 

o Notação SMILES (se aplicável); 

o InChI (caso exista) (se aplicável); 
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o Fórmula estrutural (se aplicável). 

Figura 14: Substância de referência preenchida 

 

 

Para a fórmula estrutural, aceda a «Structural formula» [Fórmula estrutural] em «Molecular 
and structural information» [Informação molecular e estrutural] e clique no botão <Add> 
[Adicionar]. Poderá então carregar um ficheiro de imagem com a fórmula estrutural (Figura 
15). 

Figura 15: Carregar a fórmula estrutural 
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4 CRIAR UM CONJUNTO DE DADOS DE UMA 
SUBSTÂNCIA 

 Se já é um utilizador experiente da IUCLID 5 e sabe como criar conjuntos de 
dados de substâncias, poderá passar directamente ao capítulo 5 do presente 
manual, onde encontrará informações para o preenchimento correcto do seu 
relatório de utilizador a jusante. 

 

Para criar um relatório de utilizador a jusante na IUCLID 5, é necessário criar primeiro um 
conjunto de dados da substância. Um conjunto de dados de uma substância é o repositório 
de dados que serve de base à criação do dossiê a apresentar à Agência.  

No separador Tasks [Tarefas] do ecrã principal da IUCLID 5 (Painel de Tarefas), em 
«Substance» [Substância], seleccione «New» [Novo] (Figura 16). 

Figura 16: Ligação para criar um novo conjunto de dados de uma substância 

 

 Escreva o nome da substância para a qual pretende criar um relatório de utilizador a 
jusante (Figura 17). O nome pode ser qualquer coisa, mas é lógico utilizar um 
identificador com o qual esteja familiarizado como, por exemplo, um nome comercial ou 
um nome de substância química. 

Figura 17: Atribuir um nome à substância 

 

 Clique no botão <Next> [Seguinte]. Seleccione a entidade jurídica a atribuir ao conjunto 
de dados da substância. 

Figura 18: Atribuir uma entidade jurídica 
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Nota: Se a entidade jurídica a associar ao conjunto de dados da substância não estiver 
disponível na lista de opções, deverá ser atribuída uma nova entidade jurídica ao utilizador. 
Para este efeito, consulte as instruções fornecidas nas secções «Criar uma entidade jurídica 
oficial» e «Transferir uma entidade jurídica oficial e importá-la para a IUCLID 5» 
apresentadas acima.  

 Clique no botão <Finish> [Concluir]. Foi criado um novo conjunto de dados da 
substância. 

 A árvore de secções do conjunto de dados da substância é apresentada na área de 

navegação do ecrã. Para uma vista completa da árvore, clique no botão  e seleccione 
«Expand all» [Expandir tudo] no menu de pop-up (Figura 19). 

Figura 19: Expandir a árvore de secções 

 

 

 A IUCLID 5 oferece também a possibilidade de realçar secções cujo preenchimento é 
sugerido, como ajuda na preparação dos vários tipos de dossiês. Para o relatório de 

utilizador a jusante, clique no botão  e seleccione «REACH Downstream user report» 
[Relatório de utilizador a jusante do REACH] na lista de opções (Figura 20). 
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Figura 20: Seleccionar o modelo na lista de opções 

 

 

As secções que, no mínimo, devem ser preenchidas para o relatório de utilizador a jusante, 
são as secções 1.1, 1.2, 1.3, 1.7, 3.3 e 3.5. As secções 2.1 para classificação e 13 para os 
dados relativos às condições de utilização devem ser preenchidas, se aplicável. 

Os detalhes das informações necessárias para preencher cada uma destas secções são 
explicados no capítulo seguinte do presente manual (capítulo 5). 

 



Manual de Apresentação de Dados 

Parte 21 - Como preparar e apresentar um 
relatório de utilizador a jusante 
através da IUCLID 5  

 

Versão 1.0  Página 22 de 68 

Data de publicação (04-2011)  

 

5 SECÇÕES DA IUCLID 5 A PREENCHER PARA 
COMPLETAR UM RELATÓRIO DE UTILIZADOR A 
JUSANTE 

O presente capítulo descreve as informações que devem ser prestadas através das 
diferentes secções da árvore da IUCLID. 

Depois de criar um conjunto de dados da substância para a sua substância e de o atribuir à 
entidade jurídica do notificante, poderá introduzir os dados relativos à substância neste 
conjunto de dados. 

Para obter o conjunto de dados da substância que criou, clique em «Update» [Actualizar] no 
menu «Substance» [Substância] no painel principal de tarefas e faça duplo clique na sua 
substância para a seleccionar na lista (nota: para obter de forma mais fácil o conjunto de 
dados da substância, poderá utilizar o sistema de filtragem, escrevendo a totalidade ou parte 
do nome da substância no campo de consulta, ou utilizar o sistema de consulta clicando no 
botão <Query> [Consultar]. 

 

Figura 21: Substância apresentada na consulta 

 

Uma vez apresentada a substância no painel de introdução de dados, expanda a árvore de 
secções (clicando no separador «Section tree» [Árvore de secções]) e preencha as secções 

necessárias. Faça duplo clique em cada secção para visualizá-las e clique no botão  

<Edit item> [Editar item] na parte superior do ecrã para preencher os campos. Clique em  
para guardar as alterações. 

 

5.1 Selector do modo de vista IUCLID 
Quando o conjunto de dados da substância for apresentado, clique na seta preta indicada 
na figura seguinte para seleccionar o modo de vista específico «REACH Downstream user 
report» [Relatório de utilizador a jusante do REACH]. 
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Figura 22: Modo de vista IUCLID 

 

 

Depois de seleccionar o modo de vista pretendido na lista pendente, a árvore de secções 
altera-se de forma a que os símbolos de folha  ou de livro  que antecedem as secções 
da IUCLID 5 tenham a cor vermelha nas secções obrigatórias ou a cor verde nas secções 
opcionais.  

 

 Tenha em atenção que este selector do modo de vista é apenas uma ferramenta que 
ajuda a determinar quais as secções a preencher. No entanto, o presente manual 
prevalece sobre este selector do modo de vista no que respeita às informações 
exigidas nos termos do Regulamento REACH. 
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5.2 Informações relativas ao Relatório de utilizador a jusante 
As informações a incluir no conjunto de dados da substância são descritas no Regulamento 
REACH (artigo 38.º, n.º 2). 

As informações obrigatórias incluem os seguintes elementos (a secção correspondente da 
IUCLID 5 é indicada entre parênteses): 

o identidade do utilizador a jusante, ou seja, nome e informações de contacto 
(conta do REACH-IT e secção 1.1. «Identification» [Identificação] da IUCLID 
5); 

o identidade da substância, conforme especificado no Anexo VI, pontos 2.1 a 
2.3.4, do Regulamento REACH (secções 1.1 «Identification» [Identificação] e 
1.2 «Composition» [Composição] da IUCLID 5); 

o o(s) número(s) de registo comunicado(s) ao utilizador a jusante pelos seus 
fornecedores, se aplicável (secção 1.3 «Identifiers») [Identificadores] da 
IUCLID 5); 

o identidade do(s) fabricante(s), importador(es) ou outro fornecedor, ou seja, 
nome, informações de contacto (secção 1.7 «Suppliers» [Fornecedores] da 
IUCLID 5); 

o instalação(ões) de utilização (secção 3.3 «Sites» [Instalações] da IUCLID 5); 

o uma descrição geral da(s) utilização(ões) (secção 3.5 «Identified uses» 
[Utilizações identificadas]) e dos dados relativos às condições de 
utilização(ões) (secção 13 «Assessment reports» [Relatórios de avaliação] da 
IUCLID 5);  

o se aplicável e de acordo com o artigo 38.º, n.2, alínea f), uma proposta para 
ensaios suplementares em animais vertebrados (registo(s) de estudo de 
parâmetros pertinente(s)). 

 

O presente capítulo do manual descreve em pormenor como preencher um relatório de 
utilizador a jusante na IUCLID 5, a fim de cumprir as suas obrigações nos termos do artigo 
38.º, n.º 2, do Regulamento REACH. 

 

5.3 Informações a prestar na secção 1.1 – «Identification» 
[Identificação] da IUCLID 5 

 

 Utilize esta secção para especificar algumas das informações obrigatórias nos termos 
do artigo 38.º, n.º 2, alíneas a) e c), do Regulamento REACH, relativas à identificação 
da substância e à identidade do utilizador a jusante. 

 

5.3.1 Identidade do utilizador a jusante 

 Embora a entidade jurídica esteja disponível no REACH-IT como parte do processo de 
inscrição, é também necessário indicar uma entidade jurídica no dossiê da IUCLID 5 
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para cumprir os requisitos do formato XML. Estas informações devem ser apresentadas 
no bloco «Substance identification» [Identificação da substância] (Figura 23). 

Figura 23: Identificação da entidade jurídica na secção 1.1 

 

 

5.3.2 Identificação da substância 

 Em primeiro lugar, seleccione o tipo de substância adequado entre os diferentes tipos 
propostos na lista de opções da composição. Seleccione entre substância 
monoconstituinte, substâncias multiconstituinte ou substância UVCB (Figura 24). 

Figura 24: tipo de substância 

 

 

 Em «Reference substance» [Substância de referência], clique no botão  para atribuir 
uma «Reference substance» à sua substância (Figura 25). 

Figura 25: Atribuir uma substância de referência 

 

 

 É apresentada uma caixa de diálogo. Procure a sua «Reference substance» [Substância 
de referência] (Figura 26). 
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Figura 26: Caixa de diálogo de consulta 

 

 

 Realce a substância de referência na lista de resultados e clique em <Assign> [Atribuir] 
(Figura 27). 
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Figura 27: Atribuir a substância de referência 

 

 

 É possível que a substância de referência já exista mas não esteja definida como 
«Active». Neste caso, desmarque a caixa de verificação «Show only active values» 
para visualizar as substâncias de referência marcadas como activas e inactivas. 
Clique com o botão direito do rato na substância não activada que pretende atribuir. 
Clique em <Active Reference substance> [Substância de referência activa] para 
activar a substância. Em seguida, clique em <Assign> [Atribuir]. 

 

 Se não conseguir encontrar a sua substância de referência pelo facto de esta ainda não 
ter sido criada: 

o Clique em <New> [Novo] para criar uma nova substância de referência 
(Figura 28); 
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Figura 28: Botão para criar uma nova substância de referência 

 

o será redireccionado para o «Reference substance assistant» [Assistente da 
substância de referência]; 

o escreva o nome da substância de referência que pretende criar e clique no 
botão <Finish> [Concluir] (Figura 29); 

Figura 29: Nome da substância de referência 

 

o para especificar as informações relativas à nova substância de referência, 
clique no botão de seta azul (Figura 30); 
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Figura 30: Botão de seta azul 

 

o poderá surgir uma caixa pop-up a perguntar se pretende guardar os dados 
alterados. Seleccione «Save» [Guardar]; 

o será redireccionado para o ecrã relativo à nova substância de referência. 
Preencha o máximo de campos possível, conforme descrito no capítulo 3.2, 
«Creating a Reference substance» [Criar uma substância de referência] 
(notação SMILES, fórmula molecular, intervalo de massas moleculares, 
fórmula estrutural, etc.); 

o seleccione «File/Edit item» [Ficheiro/Editar item] ou o botão <Edit item> [Editar 
item] , para preencher os campos; 

o clique no botão <Save> [Guardar]; 

o clique no botão  para regressar à substância (guarde quando solicitado). 

 

 Para substâncias multiconstituintes, aconselha-se que indique, no campo «IUPAC 
name» [Nome IUPAC], que se trata de uma mistura reaccional (por exemplo, mistura 
reaccional de A e B). Os constituintes devem ser indicados na secção 1.2 
«Composition» [Composição] da IUCLID 5. 

 Para substâncias UVCB, aconselha-se que indique o nome da substância UVCB no 
campo «IUPAC name» [Nome IUPAC]; a descrição do processo, o processo de 
refinação, etc., devem ser indicados no campo «Description» [Descrição]. 

 Recomenda-se igualmente que leia o Documento de orientação para a identificação e 
designação de substâncias no REACH, disponível em: 

http://guidance.echa.europa.eu/docs/guidance_document/substance_id_en.pdf 

 

 Sempre que um relatório de utilizador a jusante já aceite for actualizado (ou seja, o 
dossiê do relatório de utilizador a jusante receber um número de referência), deve 
sempre ser especificado um número CE na identificação da substância de referência 
da secção 1.1 «Identification» [Identificação] da IUCLID 5. 

Utilize o número CE ou o número CE provisório atribuído à anterior notificação de 
apresentação aceite para esta substância. 

 

5.3.3 Pessoa de contacto 

Também poderá indicar as informações da pessoa de contacto para essa substância 
específica (Figura 31). Preencha o máximo de campos possível. 

http://guidance.echa.europa.eu/docs/guidance_document/substance_id_en.pdf
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e deixar estes campos vazios, o REACH-IT utilizará, por predefinição, as informações de 
ACH-IT. 

 
Figura 31: Campos de informações de contacto 

S
contacto especificadas na sua conta do RE

 

 

5.4 Informações a prestar na secção 1.2 – «Composition» 

 

[Composição] da IUCLID 5 

 Utilize esta secção para especificar algumas das informações exigidas nos termos do 
artigo 38.º, n.º 2, alínea c), do Regulamento REACH, relativas à identidade da 

position» [Composição] e clique no botão <Edit 

substância a notificar. 

 

Indique, no mínimo, uma composição. 

 Faça duplo clique na secção 1.2 «Com
 (Figura 32). item> [Editar item]

 Clique no botão <Add> [Adicionar] . 

 Escreva o nome e uma breve descrição da sua substância.  

Figura 32: Nome e tipo de substância 

 

 



Manual de Apresentação de Dados 

Parte 21 - Como preparar e apresentar um 
relatório de utilizador a jusante 
através da IUCLID 5  

 

Versão 1.0  Página 31 de 68 

Data de publicação (04-2011)  

 

plo, uma substância com uma pureza entre 95 % 
e 98 % (w/w) deverá ser indicada conforme indicado a seguir. É necessário especificar a 
unidade para preencher esta secção. 

 

 Preencha a secção «Degree of purity» [Grau de pureza] (Figura 33). O grau de pureza a 
especificar deve corresponder à concentração do(s) principal(is) constituinte(s) da 
substância. A lista pendente permite escolher símbolos ou unidades numa lista de 
opções e as caixas permitem escrever números. Nesta parte, pode indicar o intervalo de 
pureza normal da substância. Por exem

 Grau de pureza: preencha, no mínimo, uma das caixas e seleccione a unidade. 

Figura 33: Grau de pureza 

 

 

 Abra o bloco repetível de constituintes (clicando no botão <Add> [Adicionar] ). 

 

 Indique, pelo menos, um constituinte para cada composição. 

 

 Clique no botão  para atribuir uma «Reference substance» [Substância de referência] 
ao constituinte recém-criado. Procure a substância de referência adequada e adicione-a, 
seleccionando-a e clicando em <Assign> [Atribuir]. Crie a substância de referência de 
que necessita se não tiver sido criada anteriormente. Consulte o capítulo 3 para mais 
informações. 

 

 Se a substância for uma substância monoconstituinte, indique a mesma substância 
de referência nas secções 1.1 e 1.2 da IUCLID 5. 

 

 No caso de uma substância multiconstituinte, a substância de referência atribuída na 
secção 1.1 não poderá ser nenhuma das substâncias de referência especificadas 
para os constituintes individuais na secção 1.2. 

 Se a substância notificada for uma substância multiconstituinte ou uma substância 
 de composição deverão 

Isto

o constituinte 2 identifica «200-001-8» como número CE (o número CE para 
formaldeído). 

UVCB, então na secção 1.2 todos os constituintes do bloco
representar identidades de substância distintas. 

 significa que o caso seguinte será considerado inválido: 

o constituinte 1 identifica «formaldeído» como nome IUPAC; 
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tração típica] ou o «Concentration range» 
[Intervalo de concentração] para cada constituinte, conforme indicado a seguir. 

Figura 34: Concentração típica para cada constituinte 

 Indique a “Typical concentration” [Concen

 

 

 Se for necessário especificar vários constituintes, clique no botão <Add> [Adicionar] ( ) 
na secção pertinente para que sejam apresentadas mais caixas. 

 a impurezas e aditivos 
(Figura 35).  

Figura 35: Caixas adicionais para os campos relativos a impurezas e aditivos 

 Siga o mesmo procedimento para preencher os campos relativos
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ureza ou 
aditivo afecta a classificação da substância, assinalando a respectiva caixa (Figura 36 e 
Figura 37). 

Figura 36: Indicar se uma impureza é relevante para a classificação e rotulagem da bstância 

 Caso seja comunicada uma classificação da substância: indique se cada imp

 su

 

Figura 37: Indicar se um aditivo é relevante para a classificação e rotulagem da su stância b

 

 

Clique no botão <Add> [Adicionar]  na secção pertinente para que sejam apresentadas 
mais caixas (Figura 38). 

Figura 38: Adicionar outra composição 

 

 

5.5 Informações a prestar na secção 1.3 – «Identifiers» 
[Identificadores] da IUCLID 5  

 

Ne ta
co u
núme
apres

s
m

 secção, deve adicionar o número de referência (número de registo) que lhe foi 
nicado pelo seu fornecedor na ficha de dados de segurança. Se não for indicado um 
ro de registo, deve ser apresentada uma observação para justificar a não 
entação do mesmo. 

 Se pretender apresentar uma actualização ao seu relatório de utilizador a jusante, 
deverá também adicionar o número de referência do seu relatório de utilizador a 

 Faça duplo clique em «1.3 Identifiers» [Identificadores] na vista de árvore para abrir a 
secção 1.3 do conjunto de dados da substância na IUCLID 5 e clique no botão <Edit 
item> [Editar item] (Figura 39). 

jusante anterior. Para mais informações sobre este procedimento, consulte o capítulo 8 
do presente manual. 
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Figura 39: Abrir a secção 1.3 na IUCLID 5 

 

 

 Em «Regulatory programme identifiers» [Identificadores de programas de 
regulamentação], seleccione «Add» para editar a lista de identificadores. É apresentada 
no ecrã uma janela de pop-up com o título «Regulatory programme identifier» 
[Identificadores de programas de regulamentação] (Figura 40). 
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Figura 40: Janela de pop-up «Regulatory programme identifier» [Identificadores de programas de 
regulamentação] 

 

 

 Para visualizar os identificadores de regulamentação numa lista, clique no botão <black 
arrow> [seta preta] na janela «Regulatory programme identifier» [Identificadores de 
programas de regulamentação]. 

 

 Na caixa «Regulatory programme identifier» [Identificadores de programas de 
regulamentação], preencha os campos do seguinte modo: 

o seleccione «REACH registration number» [número de registo REACH] como 
programa de regulamentação; 

o o número deve ser especificado no campo «ID»; 

o o número de registo tem o seguinte formato: 01-XXXXXXXXXX-CC-XXXX. 

 

Se não for indicado um número de registo, deve ser apresentada no campo das 
observações (Figura 41) uma justificação para a não apresentação do mesmo. 
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Figura 41: Número de registo não disponível 

 

 

5.6 Informações a prestar na secção 1.7 – «Suppliers» 
[Fornecedores] da IUCLID 5 

 

 Utilize esta secção para identificar o(s) fabricantes ou o(s) importador(es) ou outro 
fornecedor, tal como exigido no artigo 38.º, n.º 2, alínea d), do Regulamento REACH. 

 

Na secção 1.7. clique em  para associar ou criar uma entidade jurídica para o(s) seu(s) 
fornecedor(es). Pesquise a entidade jurídica, digitando o nome no campo «Legal entity 
name» [Nome da entidade jurídica] (utilize «*» como carácter universal) (Figura 42). 
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Figura 42: Associar a entidade jurídica à secção 1.7 

 

 
Seleccione a entidade jurídica e clique em <Assign> [Atribuir]. 

 

Se ainda não foi criada uma entidade jurídica para o(s) fornecedor(es), clique em «New» 
[Nova] para criá-la Figura 43). 

Figura 43: Criar uma nova entidade jurídica na secção 1.7 
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Atribua um nome à entidade jurídica e clique em «Finish» [Concluir]. O nome da entidade 
jurídica do seu fornecedor está agora visível na secção 1.7. Clique em  para aceder às 
informações da entidade jurídica. O nome da entidade jurídica é agora apresentado no 
separador «General information» [Informações gerais].  

Aceda ao separador «General information» [Informações gerais] e preencha, no mínimo, os 
seguintes campos: 

o endereço (pelo menos, um dos campos); 

o código postal; 

o país (no caso da opção «Other» [Outro], deve ser preenchido o respectivo 
campo seguinte); 

o telefone; 

o endereço de correio electrónico. 

Indique, no mínimo, uma pessoa de contacto. Clique em  para adicionar a pessoa de 
contacto do fornecedor. Devem ser preenchidos os campos seguintes para cada pessoa de 
contacto:  

o nome; 

o apelido; 

o telefone; 

o endereço de correio electrónico; 

o endereço (pelo menos, um dos campos); 

o código postal; 

o país (no caso da opção «Other» [Outro], deve ser preenchido o respectivo 
campo seguinte). 

 

Se tiver mais do que um fornecedor, crie um bloco com a entidade jurídica de cada 

fornecedor na secção 1.7, clicando em  , e forneça as informações acima indicadas sobre 
todos eles. 

 

5.7 Informações a prestar na secção 3.3 – «Sites» [Instalações] da 
IUCLID 5 

 

 Utilize esta secção para identificar a instalação onde a sua substância é utilizada, tal 
como exigido no artigo 38.º, n.º 2, alínea a), do Regulamento REACH. 

 

Em primeiro lugar, deve criar as instalações na secção pertinente do painel principal de 

tarefas  da IUCLID 5. 
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5.7.1 Criar uma instalação 

 No painel principal de tarefas, clique em «New» [Nova] em «Legal entity site» [Instalação 
da entidade jurídica]. No «Site assistant» [Assistente de instalações] apresentado, 
escreva o nome da sua instalação (Figura 44). 

Figura 44: Introduzir o nome de uma instalação 

 

 

 Atribua a entidade jurídica do utilizador a jusante à instalação e clique no botão «Finish» 
[Concluir] (Figura 45). 

Figura 45: Atribuir a entidade jurídica 

 

 É apresentado o ecrã «Legal entity» [Entidade jurídica]. Indique o endereço da sua 
instalação, incluindo a cidade e o país, bem como as informações de contacto (Figura 
46). 



Manual de Apresentação de Dados 

Parte 21 - Como preparar e apresentar um 
relatório de utilizador a jusante 
através da IUCLID 5  

 

Versão 1.0  Página 40 de 68 

Data de publicação (04-2011)  

 

Figura 46: Ecrã Entidade jurídica com informações de contacto 

 

 Clique no botão «Save» [Guardar]. Criou uma instalação de produção associada à 
entidade jurídica. 

5.7.2 Atribuir uma instalação 

 Aceda à secção 3.3 «Sites» [Instalações]. Clique no botão de cruz verde para criar um 
novo bloco repetível . São apresentados os campos onde podem ser especificadas as 

informações relativas à instalação de produção. Clique no botão de cadeia  para 
associar as instalações atribuídas à sua entidade jurídica. Seleccione a instalação e 
clique no botão «OK» (Figura 47). 
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Figura 47: Associar a instalação à entidade jurídica 

 

 Marque a caixa de verificação «Use site» [Instalação de utilização]. Se for necessário 
indicar mais instalações de utilização, clique no botão de cruz verde e repita o processo 
descrito acima. 

 

 Marque a caixa de verificação «Production site» [Instalação de produção] se precisar de 
indicar a instalação de produção. 

 

5.8 Informações a prestar na secção 3.5 – «Identified uses» 
[Utilizações identificadas] da IUCLID 5 

 

 Utilize esta secção para apresentar uma descrição da(s) utilização(ões), tal como 
exigido no artigo 38.º, n.º 2, alínea e), do Regulamento REACH. 

 

A Agência aceitará o seu dossiê desde que tenha indicado, pelo menos, uma utilização na 
secção 3.5 da IUCLID 5, identificada pelo campo «Identified use name» [Nome da utilização 
identificada]. No entanto, recomendamos que descreva o mais pormenorizadamente 
possível a(s) utilização(ões) para as quais tem de elaborar um relatório de segurança 
química, de acordo com o artigo 37.º, n.º 4, ou às quais são aplicáveis as isenções previstas 
no artigo 37.º, n.º 4, alíneas c) ou f).  

A(s) utilização(ões) deve(m) ser indicada(s) através da criação de uma entrada em, pelo 
menos, um dos quadros «Uses by workers in industrial setting» [Utilizações por 
trabalhadores em contextos industriais], «Uses by professional workers» [Utilizações por 
profissionais] e/ou «Uses by consumers» [Utilizações por consumidores] (Figura 48). 
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Figura 48: Adicionar utilizações identificadas 

 

 

5.9 Informações a prestar na secção 13 – «Data for conditions of 
use» [Dados relativos às condições de utilização] da IUCLID 5 

 

 Utilize a secção 13 para apresentar dados relativos às condições de utilização, tal 
como exigido no artigo 38.º, n.º 2, alínea e), do Regulamento REACH. 

 

 Clique com o botão direito do rato na secção «13 Assessment Reports» [13 Relatórios 
de avaliação] e seleccione «New endpoint study record» [Novo registo de estudo de 
parâmetros] (Figura 49). 
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Figura 49: Adicionar um novo registo de estudo de parâmetros 

 

 

 É apresentada a secção «New endpoint study record». Altere o nome do novo registo de 
estudo de parâmetros para «Data for conditions of use» [Dados relativos às condições 
de utilização]. 

 No ecrã seguinte, apresentado abaixo, na lista de opções existente em «Type of report» 
[Tipo de relatório], seleccione «other» [outro]. 

 No campo «document» [documento], clique no botão  e no botão <Add> [Adicionar]. 
(Guarde se o sistema o solicitar). Poderá então anexar o documento que descreve as 
condições de utilização (Figura 50). 
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Figura 50: Anexar documento separado dos dados relativos às condições de utilização 

 

 

5.10 Informações a prestar nas secções 4 a 7 – «Testing 
proposals» [Propostas de ensaio] da IUCLID 5 

 

 É possível que considere necessária a realização de ensaios em animais vertebrados 
para poder completar a avaliação de segurança química. Nesse caso, deve 
apresentar uma proposta de ensaio à Agência, como indicado no artigo 38.º, n.º 2, 
alínea f), do Regulamento REACH e esperar pela resposta antes de iniciar o ensaio. 

 

 Para adicionar uma proposta de ensaio, crie um novo registo de estudo de parâmetros 
na secção pertinente da IUCLID 5 (Figura 49).  

 
 A proposta de ensaio deve ser identificada no registo de estudo de parâmetros através 

da selecção da opção «experimental study planned» [estudo experimental planeado] no 
campo «study result type» [tipo de resultado do estudo] (Figura 51). 
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Figura 51: Lista de opções para o tipo de resultado do estudo 

 

 

 Neste caso, devem ser apresentadas informações sobre o calendário no campo «Study 
period» [Período do estudo] (Figura 52).  

Figura 52: Calendário indicado para uma proposta de ensaio 

 

 
 Além disso, devem ser apresentadas informações sobre a directriz/método no campo 

«Guideline» [Directriz] ou no campo «Principles of method if other than guideline» 
[Princípios do método se diferentes da directriz] (Figura 53) ou, em alternativa, deve 
existir um anexo no campo «Attached background material» [Material de referência 
anexado] (Figura 54). 
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Figura 53: Directriz e método utilizados 

 

 

Figura 54: Documentos de referência anexados 
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6 CRIAR UM DOSSIÊ DO RELATÓRIO DE UTILIZADOR A 
JUSANTE 

Depois de ter incluído todas as informações pertinentes no seu conjunto de dados da 
substância, o próximo passo é criar um dossiê. 

 

 No ecrã principal (Painel de Tarefas) da IUCLID 5, seleccione «Update» [Actualizar] em 
«Substance» [Substância]. 

 São apresentadas todas as substâncias disponíveis; seleccione a substância para a qual 
pretende criar o dossiê do relatório de utilizador a jusante. 

 Com o botão direito do rato, clique numa substância da lista de resultados da consulta. 
No menu de pop-up, seleccione «Create Dossier» [Criar Dossiê] (Figura 55). 

Figura 55: Seleccionar a opção Criar Dossiê no menu de pop-up 

 

 É apresentado o assistente de criação de dossiês. Siga os passos. 

 Passo 1: Seleccione o modelo de dossiê «REACH Downstream user report» [Relatório 
de utilizador a jusante do REACH] (Figura 56). 
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Figura 56: Seleccionar o modelo de dossiê e definir o nível de confidencialidade 

 

 Passo 2: Defina o nível de confidencialidade: por predefinição, é especificado «Not 
confidential» [Não confidencial]. 

Se tiver incluído um sinalizador de confidencialidade ou de programa de regulamentação no 
seu conjunto de dados da substância, certifique-se de que as informações são incluídas no 
seu relatório de utilizador a jusante, seleccionando os sinalizadores pertinentes neste passo. 
Se tiver dúvidas, recomenda-se que seleccione todos os sinalizadores potenciais, clicando 
nos dois botões <Select all> [Seleccionar todos] (Figura 56). 

 

 Passo 3: Verifique o estado de todos os documentos incluídos na criação do dossiê. 
Nesta fase, certifique-se de que todas as secções necessárias para o dossiê do relatório 
de utilizador a jusante estão marcadas, uma vez que apenas esses documentos farão 
parte do dossiê (Figura 57). As secções pertinentes para um relatório de utilizador a 
jusante são, no mínimo, as secções 1.2, 1.3 (se aplicável), 1.7, 3.3 e 3.5. 
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Figura 57: Inclusão de dados no dossiê 

 

 

 É normal que a secção 13 não seja apresentada neste ecrã; será verificada no passo 
5 da criação do dossiê. 

 

 Passo 4: Seleccione o nível de pormenor dos campos dos parâmetros. Recomenda-se a 
opção «All fields – including confidential test material information» [Todos os campos – 
incluindo as informações confidenciais sobre o material de ensaio], que é a opção 
predefinida. 

 Passo 5: Verifique se todos os objectos relevantes farão parte do dossiê (a sua própria 
entidade jurídica, a entidade jurídica do seu fornecedor, a instalação de utilização, a(s) 
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substância(s) de referência e os registo(s) de estudo de parâmetros, os dados relativos 
às condições de utilização e as propostas de ensaio, se aplicável) (Figura 58). 

Figura 58: Verificar os objectos seleccionados 

 

 

 Passo 6: Introduza informações administrativas suplementares. No campo «Name» 
[Nome], atribua um nome adequado ao seu dossiê do relatório de utilizador a jusante 
(Figura 59). 
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Figura 59: Campo para o nome e informações administrativas 
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 Uma janela informa se a importação foi bem sucedida. O dossiê será apresentado 
quando clicar no botão «View dossier» [Ver dossiê] (Figura 60). 

Figura 60: Mensagem final da criação do dossiê  

 

 

 Recomenda-se vivamente a utilização do plug-in da Verificação Técnica de 
Integralidade (VTI) neste ponto. Esta ferramenta detectará as informações em falta no 
seu dossiê antes de o exportar e de o apresentar à Agência através do REACH-IT. 

Para o efeito, clique com o botão direito do rato no dossiê e seleccione <Run TCC> 
[Executar VTI] (Figura 61). 

 

Figura 61: Executar a ferramenta VTI no dossiê 

 

Pode transferir a versão mais recente do plug-in da VTI a partir do sítio Web da 
IUCLID 5; 

http://iuclid.echa.europa.eu 

 

 

http://iuclid.echa.europa.eu/
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7 EXPORTAR O SEU DOSSIÊ DO RELATÓRIO DE 
UTILIZADOR A JUSANTE 

 O dossiê do relatório de utilizador a jusante deve ser exportado da IUCLID 5, a fim de 
ser enviado à Agência através do REACH-IT. 

 No ecrã principal de tarefas da IUCLID 5, clique no ícone de dossiê ou na ligação 
«View» [Ver] (Figura 62). 

Figura 62: Ver um dossiê 

 

 Seleccione e clique com o botão direito do rato no seu relatório de utilizador a jusante e 
seleccione «Export» [Exportar] (Figura 63). 

Figura 63: Exportar um dossiê 

 

 O assistente de exportação perguntar-lhe-á se pretende incluir as suas anotações no 
dossiê. Normalmente, seleccione «Export without annotations» [Exportar sem anotações] 
(excepto se tiver incluído informações pertinentes como, por exemplo, anotações no 
dossiê) e clique no botão <Next> [Seguinte] (Figura 64). 

Figura 64: Selecção de anotações na exportação 
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 No próximo passo, guarde o dossiê na sua unidade de disco rígido. Clique no botão 

( ) para especificar a localização onde pretende armazenar o dossiê (Figura 65). 

Figura 65: Botão «Save» [Guardar] e localização 

 

 Agora, clique no botão <Finish> [Concluir]. O dossiê foi exportado para a localização 
especificada e será apresentada uma mensagem de confirmação (Figura 66). 

Figura 66: Relatório de progresso da exportação 

 

Para apresentar o seu dossiê à Agência através da REACH�IT, consulte o capítulo 9. 
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8 ACTUALIZAR UM DOSSIÊ 

Se tiver de enviar informações suplementares relativas ao relatório de utilizador a jusante, 
não será necessário escrever novamente todos os dados da substância. 

 No ecrã principal, aceda a tarefas e, em «Substance» [Substância], clique em «Update» 
[Actualizar] (Figura 67). 

Figura 67: Selecção da ligação de actualização 

 

 Na lista, seleccione e faça duplo clique na substância para a qual pretende enviar novas 
informações. Na vista de árvore do conjunto de dados da substância, seleccione a(s) 
secção(ões) que pretende actualizar. Clique no botão <Edit item> [Editar item] para 

editar as secções necessárias . 

 Na secção 1.3 da IUCLID 5, adicione o número de referência já atribuído à sua 
substância, caso pretenda apresentar uma actualização do relatório de utilizador a 
jusante. Para indicar este número de referência, seleccione «other» [outro] na lista de 
opções do programa de regulamentação (Figura 68). Para mais informações sobre o 
presente manual, consulte o capítulo 5.5 no ponto 1.3. 

 

Figura 68: Indicação do número de referência do relatório de utilizador a jusante na secção 1.3 da IUCLID 
5 relativa ao conjunto de dados da substância 

 

 

 Crie um dossiê a partir do seu conjunto de dados da substância actualizado. Ao criar o 
seu dossiê actualizado, especifique o número da última apresentação aceite e o motivo 
da actualização no passo 6 do assistente de criação do dossiê (título do dossiê) (Figura 
69).  
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Figura 69: Especificar um motivo para a actualização 

 

 

 Se o motivo da actualização espontânea não estiver indicado na lista pendente, 
seleccione a opção «other:» [outro:] e especifique o motivo no campo correspondente 
(Figura 70). 

 

Figura 70: Especificar o «Other» [Outro] motivo 

 

 

Para criar e exportar o dossiê, consulte os capítulos 6 e 7 do presente manual. 
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 No caso de cessar a utilização comunicada, deverá apresentar uma actualização do 
seu dossiê da IUCLID 5. Poderá informar a Agência directamente no REACH-IT 
através da funcionalidade «Cease manufacture» [Cessação do fabrico]. Do mesmo 
modo, se a utilização recomeçar, também poderá notificar a Agência através da opção 
«Restart functionality» [Reiniciar funcionalidade]. Estão disponíveis informações 
pormenorizadas sobre a utilização destas funcionalidades no capítulo 3.4 do Manual 
de Utilização para a Indústria - Parte 6: Apresentação de dossiês do REACH-IT em: 

http://echa.europa.eu/reachit/ium_pt.asp 

 

http://echa.europa.eu/reachit/ium_en.asp
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9 APRESENTAR UM RELATÓRIO DE UTILIZADOR A 
JUSANTE À ECHA 

 

9.1 Passo 1: Inscrição da empresa no REACH-IT  

 Se não tem uma conta no REACH-IT, consulte o Manual de Utilização para a Indústria – 
Parte 2 no seguinte endereço: 

  http://echa.europa.eu/reachit/createaccount-it_pt.asp 

 Se já tem uma conta no REACH-IT pode ignorar este passo. 

 

9.2 Passo 2: Iniciar sessão no REACH-IT 

 Para aceder ao REACH-IT, aceda ao sítio Web da Agência no seguinte endereço: 

  https://reach-it.echa.europa.eu/reach/public/welcome.faces 

 No REACH-IT, clique em «login» [Iniciar sessão] (Figura 71). 

Figura 71: Iniciar sessão no REACH-IT 

 

 

9.3 Passo 3: Iniciar a apresentação de um relatório de utilizador a 
jusante  

 

 Para iniciar a apresentação do dossiê, aceda ao menu <Downstream user report> 
[Relatório de utilizador a jusante] e clique em <Submit downstream user report> 
[Apresentar relatório de utilizador a jusante] (Figura 72). 

http://echa.europa.eu/reachit/createaccount-it_en.asp
https://reach-it.echa.europa.eu/reach/public/welcome.faces
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Figura 72: Iniciar a apresentação de um relatório de utilizador a jusante, opção 1 

 
 
 Em alternativa, poderá iniciar a apresentação do dossiê, acedendo ao menu 

<Registration/notification> [Registo/notificação] e clicando em <Submit 
registration/notification> [Apresentar registo/notificação] (Figura 73). 

Figura 73: Iniciar a apresentação de um relatório de utilizador a jusante, opção 2 
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 Na lista pendente do tipo de apresentação, seleccione <Downstream user report> 
[Relatório de utilizador a jusante]. 

 
Figura 74: Seleccionar o tipo de apresentação no REACH-IT 

 

 

 É aberta a página <Submit Dossier intro> [Apresentar Dossiê – Introdução] (Figura 75). 

 

9.4 Passo 4: Preencher a introdução da apresentação do dossiê 
 

Devem ser indicadas as seguintes informações: 

Declaração: Assinale a caixa de verificação para aceitar a declaração (Figura 75). 

Figura 75: Introdução da apresentação do dossiê 
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Motivo(s) para a apresentação do relatório de utilizador a jusante: deve seleccionar 
uma das seguintes opções: 

o «The particular use(s) is/are not covered in the exposure scenarios received 
from our supplier because we prefer not to provide the information on our uses 
(and our further supply chain) due to: (a) CBI (confidential business 
information) reasons; (b) Burdens of supply chain communication 
mechanisms; (c) Other reasons (please specify those reasons in the adjacent 
free-text field)» [A(s) utilização(ões) específica(s) não está(ão) abrangida(s) 
pelos cenários de exposição recebidos do fornecedor porque preferimos não 
fornecer informações sobre as nossas utilizações (e sobre a nossa cadeia de 
abastecimento posterior) devido a: a) CBI (informações comerciais 
confidenciais); b) Encargos com mecanismos de comunicação da cadeia de 
abastecimento; c) Outros motivos (especifique esses motivos no campo de 
texto livre adjacente)] (Figura 76). 

Figura 76. Especificar os motivos para a apresentação de um relatório de utilizador a jusante (I) 

 

o «The particular use(s) are not covered in the exposure scenarios received 
from our supplier although we communicated relevant information on our 
use(s) (and the further supply chain) due to: (a) Exposure scenario title(s) 
is/are inconsistent with our actual use(s); (b) Our conditions of use are outside 
the conditions described in the exposure scenario; (c) Our use is advised 
against by the supplier; (d) Other reasons (please specify those reasons in the 
adjacent free-text field)» [A(s) utilização(ões) específica(s) não está(ão) 
abrangida(s) pelos cenários de exposição recebidos do fornecedor embora 
comuniquemos informações pertinentes sobre as nossas utilizações (e sobre 
a nossa cadeia de abastecimento posterior) devido a: a) Os título(s) do 
cenário de exposição são inconsistente(s) com a(s) nossa(s) utilização(ões) 
actual(ais); b) As nossas condições de utilização não estão abrangidas pelas 
condições descritas no cenário de exposição; c) A nossa utilização é 
desaconselhada pelo fornecedor; d) Outros motivos (especifique esses 
motivos no campo de texto livre adjacente)] (Figura 77). 
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Figura 77. Especificar os motivos para a apresentação de um relatório de utilizador a jusante (II) 

 

Incluir isenções para o relatório de segurança química do utilizador a jusante: assinale 
esta caixa se não estiver a elaborar um relatório de segurança química (CSR) com base nas 
isenções previstas no artigo 37.º, n.º 4, alíneas c) ou f), do Regulamento REACH. Ao 
seleccionar a caixa de verificação, serão apresentadas mais duas caixas de verificação para 
os artigos pertinentes (Figura 78). 

Figura 78: Incluir isenções para o relatório de segurança química do utilizador a jusante 

 

Clique em <Proceed> [Avançar] para aceder ao passo seguinte. 
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9.5 Passo 5: Carregar o seu dossiê de relatório de utilizador a 
jusante 

 Preencha os campos obrigatórios (*) relativos ao nome do ficheiro e ao texto CAPTCHA 
(Figura 79). 

Figura 79: Apresentar dossiê 

 

 Clique em <Browse> [Procurar] para abrir uma caixa de diálogo que lhe permitirá 
seleccionar o ficheiro de dossiê que pretende carregar. A ligação para o ficheiro .i5z 
armazenado localmente é apresentada no campo <File name> [Nome do ficheiro]. 

 

 O seu relatório de utilizador a jusante já deverá ter sido criado na IUCLID 5 e ter a 
extensão «.i5z». 

  

 Introduza o texto CAPTCHA apresentado (*). 

 

 O carregamento de dossiês com tamanho de ficheiro superior a 20 MB deve ser 
previamente aprovado pela Agência. Clique em <request a large file access code> 
[pedir código de acesso a um ficheiro grande]. 

 

 Em seguida, clique em <Submit dossier> [Apresentar dossiê]. Depois de apresentar o 
dossiê, uma barra de progresso mostrará o estado do processo de carregamento. 

Quando o carregamento do dossiê termina, é apresentada a página <Confirm Dossier 
Submission> [Confirmar Apresentação do Dossiê] (Figura 80). 
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Figura 80: Página Confirmar Apresentação do Dossiê 

 

 

Verifique cuidadosamente os seus dados e clique em <Confirm submission> [Confirmar 
apresentação] para finalizar a apresentação do dossiê.  

Se optar por não prosseguir com a apresentação, clique em <Cancel submission> [Cancelar 
apresentação] e as informações carregadas não serão armazenadas no sistema REACH-IT. 

 

9.6 Passo 6: Confirmar a apresentação do seu relatório de 
utilizador a jusante 

É aberta a página “Dossier Submission Successful” [Apresentação de Dossiê Aceite] (Figura 
81). A página apresenta uma mensagem de confirmação e indica o seu número de 
apresentação. Receberá igualmente uma mensagem de confirmação com o relatório de 
apresentação na sua caixa de mensagens do REACH-IT. 

Figura 81: Acusar a apresentação do dossiê com o número de apresentação preliminar 
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Clique em <Message box> [Caixa de mensagens] para aceder ao relatório da apresentação 
(Clique em <Download submission report> [Transferir relatório de apresentação]) (Figura 
82). 

Figura 82: Página da caixa de mensagens 

 

 

9.7 Passo 7: Receber o número de referência 
Se a apresentação estiver completa e for aprovada na verificação das Regras de Negócio, 
receberá uma segunda mensagem (Figura 83) com o número de referência e um relatório 
de apresentação actualizado (Figura 84) na sua caixa de mensagens do REACH-IT.  

Figura 83: Mensagem interna com o número de referência 
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Figura 84: Relatório de apresentação 

 

 

9.8 Falhas na apresentação do dossiê 
 

As falhas nas apresentações são sempre comunicadas através de uma mensagem interna 
enviada para a sua caixa de mensagens no REACH-IT. 

Clique na ligação <Show> [Mostrar] para ver os detalhes da mensagem (Figura 85); por 
exemplo, o dossiê viola uma regra de negócio ou o formato do ficheiro é inválido. A 
mensagem fornece uma explicação para a falha do dossiê. A informação prestada na 
mensagem é apenas um resumo. 
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Para obter mais informações, pode seleccionar <Download submission report> [Transferir o 
relatório de apresentação] (em formato .pdf) ou <Go to dossier> [Aceder ao dossiê] para 
consultar as informações completas do dossiê. 

 

Figura 85: Mensagem interna com detalhes sobre a falha na apresentação do dossiê 

 

 

 

 

 

Se tiver dúvidas relacionadas com um dossiê específico apresentado à Agência, poderá 
contactar-nos através do formulário de pedido de informações disponível na secção do 
serviço de assistência da ECHA no seguinte endereço: 
http://apps.echa.europa.eu/forms/helpdesk_form.aspx 

 

 

 

http://apps.echa.europa.eu/forms/helpdesk_form.aspx
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